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THIEÁT KEÁ MAÏCH IN MAÏCH ÑIEÀU CHÆNH  
VAØ OÅN ÑÒNH TOÁC ÑOÄ ÑOÄNG CÔ 

 Baøi taäp naøy seõ höôùng daãn caùc baïn veõ sô ñoà nguyeân lyù vaø thieát keá maïch in cho maïch oån 
ñònh toác ñoä ñoäng cô coù sô ñoà nguyeân lyù sau: 

 
 Nguyeân lyù hoaït ñoäng cuûa maïch nhö sau : Khi ñoäng cô ñöôïc noái ñeán J1 quay seõ cho ra 
ñieän aùp caûm öùng ñaët vaøo chaân soá 1 cuûa Triac. Neáu ñoäng cô bò giaûm toác ñoä (coù theå do taûi taêng 
leân) laøm V1 giaûm, D2 seõ daãn ñieän taïo doøng kích cho Triac. Doøng ñieän qua Triac taêng leân seõ laøm 
taêng toác ñoä ñoäng cô leân nhö cuõ. Neáu ñoäng cô bò taêng toác ñoä (coù theå do taûi giaûm xuoáng) laøm V1 
taêng , D2 bò phaân cöïc ngöôïc seõ ngöng daãn, giaûm doøng ñieän caáp cho ñoäng cô, toác ñoä ñoäng cô 
giaûm xuoáng nhö cuõ. 

 Veõ sô ñoà nguyeân lyù: 

 Ñeå veõ sô ñoà nguyeân lyù ta choïn Start > Programs > Orcad Realease 9 > Capture CIS 
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 Bieåu töôïng cuûa chöông trình Orcad Release 9 xuaát hieän treân maøn hình. 

 

Treân maøn hình cöûa soå Orcad 
Capture xuaát hieän, ñeå taïo sô ñoà 
nguyeân lyù môùi haõy nhaáp chuoät vaøo 
menu File > New > Project.  

Hoäp thoaïi New Project xuaát hieän, taïi khung Name nhaäp vaøo teân cuûa sô ñoà nguyeân lyù seõ 
taïo. Nhaáp vaøo nuùt Browse ñeå choïn ñöôøng daãn chöùa sô ñoà maïch, taïi khung Location baïn thaáy 
hieån thò teân ñöôøng daãn ñaõ choïn. Nhaáp OK ñeå trôû veà maøn hình laøm vieäc. 
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Quan saùt sô ñoà nguyeân lyù treân baïn  thaáy trong sô ñoà goàm coù caùc linh kieän sau: 5 ñieän trôû 
R, 1 bieán trôû, 3 diode, 2 tuï ñieän, 1 cuoän daây, 1 triac, 1 coâng taéc ba chaáu, 2 transistor loaïi 
npn, 6 chaân nguoàn noái mass. 

             Ñeå tieán haønh laáy linh kieän ta nhaáp choïn Place > Part hoaëc nhaáp choïn bieåu töôïng Place 
Part treân thanh coâng cuï.  

                   
Hoäp thoaïi Place Part xuaát hieän treân maøn hình, tröôùc tieân laáy ñieän trôû R baèng caùch choïn 

thö vieän DISCRETE trong khung Libraries, taïi khung Part ta nhaäp vaøo kyù töï R sau ñoù nhaáp 
OK ñeå trôû veà maøn hình laøm vieäc.  

 
 Taïi maøn hình laøm vieäc nhaáp chuoät taïi 5vò trí khaùc nhau ñeå choïn 5 ñieän trôû. Sau ñoù, nhaáp 
vaøo bieåu töôïng Select treân thanh coâng cuï ñeå keát thuùc vieäc laáy linh kieän R.  
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Baïn laáy bieán 
trôû baèng caùch choïn 
RESISTOR VAR taïi 
khung Part cuûa thö 
vieän DISCRETE sau 
ñoù nhaáp OK ñeå trôû veà 
maøn hình laøm vieäc. 

 

 
 Ñeå laáy tuï ñieän 
khoâng phaân cöïc choïn 
CAP NP taïi khung 
Part cuûa thö vieän 
DISCRETE sau ñoù 
nhaáp OK ñeå trôû veà 
maøn hình laøm vieäc. 

 

 
 Tieáp theo, baïn 
choïn DIODE taïi 
khung Part cuûa thö 
vieän DISCRETE ñeå 
choïn diode, sau ñoù 
nhaáp OK ñeå trôû veà 
maøn hình laøm vieäc. 
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Choïn coâng taéc 3 chaáu baèng caùch choïn SW MAG-SPDT trong thö vieän DISCRETE sau 
ñoù nhaáp OK ñeå trôû veà maøn hình laøm vieäc.  

Taïi maøn hình laøm vieäc nhaáp chuoät taïi 1 vò trí ñeå choïn 1 coâng taéc. 

 
 Ñeå choïn Triac, taïi khung Part cuûa thö vieän DISCRETE choïn T2801 sau ñoù nhaáp OK ñeå 
trôû veà maøn hình laøm vieäc. Taïi maøn hình laøm vieäc nhaáp chuoät vaøo moät vò trí ñeå choïn moät Triac. 

 
 Choïn cuoän daây baèng caùch taïi khung Part cuûa thö vieän  DISCRETE choïn INDUCTOR 
FERRITE hình daïng cuoän daây seõ hieån thò trong khung Preview naèm beân phaûi khung Libraries. 
Sau ñoù nhaáp OK ñeå trôû veà maøn hình laøm vieäc. 
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Tieáp theo, choïn 

transistor npn. Vì trong thö vieän 
DISCRETE khoâng coù transistor 
npn neân baïn haõy choïn thö vieän 
TRANSISTOR baèng caùch taïi 
khung Part cuûa thö vieän naøy 
choïn 2N2222 sau ñoù nhaáp OK 
ñeå trôû veà maøn hình laøm vieäc. 
Taïi maøn hình laøm vieäc, nhaáp 
chuoät vaøo hai vò trí khaùc nhau 
ñeå choïn hai Transistor. 

 
Ñeå choïn chaân caém cho 

linh kieän, baïn choïn thö vieän 
CONNECTOR, taïi khung Part 
choïn CON2 sau ñoù nhaáp OK ñeå 
trôû veà maøn hình laøm vieäc. 
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    Cuoái cuøng, choïn chaân Mass baèng caùch nhaáp 
choïn bieåu töôïng Place power treân thanh coâng cuï.  

 
 Khi ñoù, hoäp thoaïi Place Power xuaát hieän, taïi khung Libraries choïn CAPSYM, taïi 
khung Symbol choïn GND POWER, sau ñoù nhaáp OK ñeå trôû veà maøn hình laøm vieäc.   

 
 Keát thuùc vieäc laáy linh kieän, baïn ñöôïc caùc linh kieän treân maøn hình thieát keá nhö sau: 

 
Tieáp theo, baïn tieán haønh saép xeáp linh kieän. Ñeå di chuyeån linh 

kieän, haõy nhaáp choïn linh kieän (linh kieän ñoåi maøu) sau ñoù reâ chuoät 
ñeán vò trí thích hôïp roài thaû chuoät. Trong quaù trình saép xeáp linh kieän, 
baïn coù theå xoay linh kieän moät goùc 900 baèng caùch nhaáp choïn linh kieän 
(linh kieän ñoåi maøu), sau ñoù nhaáp phaûi chuoät vaø choïn leänh Rotate töø 
menu ñoå xuoáng.  

Ñeå xoay linh kieän ñoái xöùng theo truïc Y, baïn nhaáp 
choïn linh kieän (linh kieän ñoåi maøu) sau ñoù nhaáp phaûi chuoät 
vaø choïn leänh Mirror Horizontally töø menu ñoå xuoáng. 
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Baïn cuõng coù theå xoay linh kieän ñoái xöùng theo truïc X 
baèng caùch nhaáp choïn linh kieän (linh kieän ñoåi maøu) sau ñoù 
nhaáp phaûi chuoät vaø choïn leänh Mirror Vertically töø menu ñoå 
xuoáng. 

 
 Sau khi saép xeáp linh kieän, baïn coù vò trí caùc linh kieän treân maøn hình thieát keá nhö sau: 

 
 Ñeå noái daây cho maïch ñieän, nhaáp choïn Place > Wire hoaëc nhaáp choïn bieåu töôïng Place 
Wire treân thanh coâng cuï. Sau ñoù tieán haønh noái maïch theo sô ñoà nguyeân lyù.  

            

 Muoán thay ñoåi 
giaù trò cho linh kieän, 
haõy nhaáp ñuùp chuoät 
vaøo linh kieän. Khi ñoù 
hoäp thoaïi Display 
Properties xuaát hieän, 
taïi khung Value cuûa 
hoäp thoaïi nhaäp vaøo giaù 
trò muoán thay ñoåi sau 
ñoù nhaáp OK ñeå trôû veà 
maøn hình laøm vieäc. 
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 Sau khi noái daây vaø thay ñoåi giaù trò linh kieän, taïi maøn hình thieát keá baïn coù sô ñoà maïch 
nguyeân lyù sau: 

 
 Nhaáp vaøo bieåu töôïng Save Document treân thanh coâng cuï ñeå löu 
laïi sô ñoà maïch nguyeân lyù.  

 Moät hoäp thoaïi xuaát hieän, nhaáp OK ñeå tieáp tuïc. 

 
         Nhaáp vaøo nuùt Restore treân cöûa soå ñeå thu nhoû maøn hình laøm vieäc. Kích 
hoaït cöûa soå quaûn lyù Project ñeå nhaáp choïn trang sô ñoà vöøa thieát keá. Sau ñoù 
nhaáp choïn bieåu töôïng Design rules check treân thanh coâng cuï ñeå kieåm tra sô 
ñoà nguyeân lyù  
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 Hoäp thoaïi 
Design Rules 
Check xuaát hieän, 
nhaáp OK ñeå kieåm 
tra. 

           Nhaáp choïn 
bieåu töôïng Create 
netlist treân thanh 
coâng cuï ñeå taïo taäp 
tin netlist coù phaàn 
môû roäng .MNL 

           Hoäp thoaïi 
Create netlist xuaát 
hieän, choïn nhaõn 
Layout, taïi khung 
Netlist File choïn thö 
muïc chöùa taäp tin 
.MNL. Choïn xong 
nhaáp chuoät vaøo nuùt 
OK.  
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 Moät thoâng baùo cuûa chöông trình xuaát hieän cho baïn bieát, thieát keá baïn vöøa taïo seõ ñöôïc löu 
trong danh saùch maïng. Nhaáp OK.  

 
 Nhaáp vaøo bieåu töôïng chöông trình ôû treân goùc traùi maøn hình vaø 
choïn leänh Close ñeå thoaùt khoûi chöông trình thieát keá Capture. 

         Taïo maïch in töø sô ñoà nguuyeân lyù vöøa thieát keá, duøng chöông 
trình Layout. Khôûi ñoäng chöông trình OrCAD Layout baèng caùch 
choïn Start > Programs > OrCAD Release 9 > Layout Plus. 
  

 
           Maøn hình Layout xuaát hieän, 
choïn File > New hoaëc nhaáp vaøo bieåu 
töôïng Open new board treân thanh 
coâng cuï.    
 Hoäp thoaïi Load 
Template File xuaát 
hieän. Beân trong hoäp 
thoaïi naøy laø danh saùch 
caùc taäp tin baûng maïch 
vôùi caùc kích thöôùc maåu. 
Ñeå coù theå töï ñònh kích 
thöôùc, baïn haõy choïn taäp 
tin DEFAULT>TCH 
sau ñoù nhaáp Open.  

 
 Hoäp thoaïi Load Netlist Source xuaát hieän. Trong hoäp thoaïi naøy choïn taäp tin .MNL ñaõ taïo 
ra trong chöông trình veõ maïch nguyeân lyù Capture. Choïn xong nhaáp chuoät vaøo nuùt Open.  
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 Hoäp thoaïi Save File As xuaát hieän yeâu caàu baïn haõy nhaäp teân ñeå löu baûng maïch saép ñöôïc 
taïo ra.  

Nhaáp nuùt Save ñeå tieáp tuïc. 

 
 Hoäp thoaïi Link Footprint to Component xuaát hieän thoâng baùo cho baïn bieát raèng chöông 
trình khoâng theå tìm thaáy chaân caém cho linh kieän L1, baïn caàn phaûi choïn chaân cho L1 (coù teân laø 
INDUCTOR_FERRITE). Nhaáp traùi chuoät vaøo nuùt Link existing footprint to Component… 
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 Hoäp thoaïi Footprint for INDUCTOR_FERRITE xuaát hieän cho pheùp baïn choïn chaân 
cho linh kieän. Trong khung Libraries cuûa hoäp thoaïi, choïn thö vieän chaân caém JUMPER vaø trong 
khung Footprints choïn chaân caém mang teân JUMPER100, nhaáp Ok ñeå chaáp nhaän.    

 
 Hoäp thoaïi Link Footprint to 
Component xuaát hieän, thoâng baùo cho 
baïn bieát raèng chöông trình khoâng theå 
tìm thaáy chaân caém cho linh kieän Q1 coù 
teân laø T2801, nhaáp traùi chuoät vaøo nuùt 
Link existing footprint to 
Component… ñeå choïn. 

  
 Hoäp thoaïi Footprint 
for T2801 xuaát hieän cho 
pheùp baïn choïn chaân caém cho 
linh kieän. Trong khung 
Libraries cuûa hoäp thoaïi choïn 
thö vieän chaân caém TO vaø 
trong khung Footprint choïn 
chaân caém mang teân 
TO202AB, nhaáp OK ñeå chaáp 
nhaän.  
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      Hoäp thoaïi Link Footprint to 
Component xuaát hieän thoâng baùo cho baïn 
bieát raèng chöông trình khoâng theå tìm thaáy 
chaân caém cho linh kieän SW1. Nhaáp vaøo 
nuùt Link existing footprint to 
component… ñeå choïn.  

      Hoäp thoaïi Footprint for 
SW_MAG-SPDT xuaát hieän cho pheùp 
baïn choïn chaân caém cho linh kieän. Trong 
khung Libraries cuûa hoäp thoaïi, choïn thö 
vieän chaân caém TO, vaø trong khung 
Footprints choïn chaân caém mang teân 
TO202AB. Nhaáp OK ñeå chaáp nhaän 

 

 
 Treân maøn hình cuûa chöông trình xuaát hieän toaøn boä caùc hình daïng chaân caém cuûa linh kieän 
vaø daây noái giöõa caùc chaân linh kieän nhö sau: 
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            Nhaáp chuoät vaøo bieåu töôïng Reconect Mode treân thanh coâng cuï ñeå 
xoùa caùc daây noái giöõa caùc chaân linh kieän giuùp cho vieäc di chuyeån linh kieän 
ñöôïc deã daøng.  

Baïn thaáy hình daïng caùc chaân linh kieän treân maøn hình nhö sau: 

 

 
 Nhaáp chuoät vaøo bieåu töôïng Text Tool treân thanh coâng cuï, di 
chuyeån con troû chuoät ñeán caùc vaên baûn sau ñoù nhaáp traùi chuoät ñeå choïn 
vaên baûn, nhaán phím Delete treân baøn phím ñeå xoùa . 

 
  Ñeå saép xeáp linh kieän, nhaáp choïn bieåu töôïng Component Tool 
treân thanh coâng cuï. Sau ñoù ñöa con troû chuoät ñeán linh kieän muoán saép 
xeáp, nhaáp chuoät ñeå choïn noù, di chuyeån chuoät ñeán vò trí muoán ñaët vaø nhaáp 
chuoät ñeå ñònh vò. Trong quaù trình di chuyeån, baïn coù theå nhaán phím R treân 
baøn phím ñeå xoay caùc linh kieän moät goùc 900 

 

 Sau khi saép xeáp, baïn thaáy vò trí caùc chaân linh kieän treân maøn hình nhö sau: 
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Tieáp theo baïn haõy choïn lôùp ñeå taïo maïch in. Nhaáp 
chuoät vaøo bieåu töôïng View Spreadsheet treân thanh coâng 
cuï, sau ñoù choïn leänh Strategy > Route Layer töø menu ñoå 
xuoáng. 

 

 
 Hoäp thoaïi Route Layer xuaát hieän, taïi muïc Enabled nhaáp choïn caùc lôùp khoâng veõ maïch 
in, sau ñoù nhaáp phaûi chuoät vaø choïn leänh Properties töø menu ñoå xuoáng. 

 
 Khi ñoù hoäp thoaïi Edit Layer Strategy xuaát hieän, boû daáu choïn tröôùc muïc Routing 
Enable, sau ñoù nhaáp OK. 

 
Taïi hoäp thoaïi Route Layer, caùc lôùp ñöôïc choïn ñaõ chuyeån töø Yes sang No. Nhaáp vaøo 

bieåu töôïng Close taïi phía treân  goùc phaûi cuûa hoäp thoaïi Route Layer ñeå ñoùng hoäp thoaïi naøy. 
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Ñeå choïn chieàu daøi, chieàu roäng vaø chieàu cao cuûa ñöôøng 
maïch in, nhaáp vaøo bieåu töôïng View Spreadsheet treân thanh 
coâng cuï sau ñoù choïn leänh Nets töø menu ñoå xuoáng.  

            Hoäp thoaïi Nets xuaát hieän, taïi khung  Width Min Conn 
Max nhaáp choïn taát caû caùc oâ cuûa khung, sau ñoù nhaáp phaûi chuoät 
vaø choïn leänh Properties töø menu ñoå xuoáng 
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 Hoäp thoaïi Edit Nets 
xuaát hieän, laàn löôït nhaäp vaøo 
caùc soá 14,15,16 taïi caùc 
khung Min Width, Conn 
Width, Max Width, sau ñoù 
nhaáp chuoät vaøo nuùt OK. 

 
 Luùc naøy, taïi khung Width Min Conn Max cuûa hoäp thoaïi Nets baïn thaáy xuaát hieän caùc soá 
14, 15, 16. Nhaáp vaøo nuùt Close ôû phía treân beân phaûi hoäp thoaïi Nets ñeå ñoùng hoäp thoaïi laïi. 

 
 Nhaáp vaøo bieåu töôïng Obstacle 

Tool treân thanh coâng cuï ñeå veõ khung 
cho maïch in.    

 
 Sau khi veõ khung cho maïch in, 
baïn thaáy baûng maïch in treân maøn hình 
nhö sau:  
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Ñeå chaïy maïch in, nhaáp chuoät choïn 
Auto > Autoroute > Board ñeå chaïy maïch in 
töï ñoäng. 

        Sau khi ñaõ veõ xong caùc ñöôøng maïch in, 
moät hoäp thoaïi xuaát hieän thoâng baùo vieäc veõ 
maïch in ñaõ hoaøn taát. Nhaáp chuoät vaøo nuùt OK 
ñeå chaáp nhaän.  

 
 Nhaáp vaøo bieåu töôïng Zoom All treân thanh coâng cuï ñeå phoùng to vaø ñöa baûng maïch in vaøo 
ôû giöõa maøn hình laøm vieäc. 

 
 Treân maøn hình, baïn thaáy baûng maïch in ñaõ hoaøn taát nhö sau:  

 
 Ñeå ñaët teân leân baûng maïch in, nhaáp vaøo bieåu töôïng Text Tool treân thanh coâng cuï sau ñoù 
nhaáp phaûi chuoät vaø choïn leänh New töø menu ñoå xuoáng.  

                              

ÑAÏI HOÏC SÖ PHAÏM KYÕ THUAÄT – KHOA ÑIEÄN   BIEÂN SOAÏN : PHAÏM QUANG HUY  -  HUYØNH MINH ÑAÊNG 154 



GIAÙO TRÌNH EDA (ELECTRONIC DESIGN AUTOMATION) - TÖÏ ÑOÄNG THIEÁT KEÁ MAÏCH ÑIEÄN TÖÛ VÔÙI ORCAD          BAØI TAÄP 6 
 

 Khi ñoù, hoäp thoaïi Text Edit xuaát hieän, taïi khung beân phaûi muïc Text String nhaäp vaøo 
teân maïch in sau ñoù nhaáp OK.  

 
  Sau khi nhaáp OK taïi ñaàu con troû chuoät xuaát hieän khung teân hình chöõ nhaät cuûa baûng 

maïch in, di chuyeån chuoät vaøo vò trí thích hôïp ñeå ñaët khung teân cho maïch in.   

0 

Muoán xem caùc lôùp maïch in maø khoâng caàn hieån thò chaân linh kieän, nhaán vaøo phím 
Backspace treân baøn phím, luùc naøy treân maøn hình baïn thaáy toaøn boä baûng maïch in maát ñi.Muoán 
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xem lôùp döôùi maïch in, nhaán vaøo phím soá 1 treân baøn phím. Khi ñoù lôùp döôùi cuûa baûng maïch in 
ñöôïc hieån thò nhö sau :   

 
    Muoán hieån thò laïi toaøn boä maïch in, nhaáp 

choïn View > Design  

   Ñeå löu laïi baûng maïch in, nhaáp vaøo bieåu 
töôïng ñóa meàm treân coâng cuï .  

   
 

 

.  
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